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Introduction 
The Journal Program is designed as a daily information manager.  Information can easily be retrieved from
the Clipboard or  existing disk files and stored for later retrival.  Information is stored in topics.  The topic
titles are displayed in a listbox at the left  of the screen and the information associated with that title in a text
box.  Topics can be organized into up to eight different  categories.  Topics can be moved from one category
to another.  The date the information is input into Journal ia automatically  (default mode, can be turned off)
appended  to the beginning of the titles. 

A DAILYCLP Button is always displayed and can be used to grab text currently on the Clipboard and add it
as a new topic to the currently open Category. 

Important Restrictions
Windows Enhanced Mode Required.

Windows must be operating in the Enhanced Mode to run this program.

The following files CANNOT be edited or moved separately: JOURNAL.Dat, ANOTE.JOU through 
HNOTE.JOU and ANOTE.BAK through HNOTE.BAK.  All of these files MUST BE KEPT TOGETHER
at all times.  They can be moved to another machine ONLY if ALL are moved together.  If you want to move 
individual categories see How to Remove Categories to FIle and  How to Add Categories from File.
It is important to appreciate the difference between adding new categories with Journal using the Set 
Categories from the Topics Menu AND adding new Categories from file.  All categories must be created 
within Journal.  Remove to File and Add from File under the File Menu provides the capability to save and 
restore categories created by Journal.

Program Capacities 
Categories: 8.   The first  is fixed as DailyJou and is the opening default  category.  The  

other seven can be configured by the user.
Topics:  400 per category 
Topic text: Maximum of 30K per topic.  The sum of information in all topic text fields of an 

individual category cannot exceed 1Meg. 
**  Additional categories may be saved to disk, only 8 can be active in the program at any one time.  See
instructions under the File Menu, Remove Category to File and Add Category fm File.

Getting Started:

Program Files:
Journal.exe Main Program File
Journal.hlp Windows Help File for Journal
Muscle.vbx Required DLL
Threed.vbx Required DLL
VBrun100.dll Required DLL (NOT DISTRIBUTED WITH THE PROGRAM)
Commdlg.dll Required DLL (NOT DISTRIBUTED WITH THE PROGRAM)
Journal.wri Program Manual

Files Created by the Program (all in the program subdirectory.  These files SHOULD NOT be edited with
another file editor as this would destroy the structure making them unusable within Journal)

Journal.dat Created the first time the program runs.  Holds topic titles.
Journal.bak Journal.dat backup, created when you choose BACKUP FILES
Anotes.jou Topic text for the first category
Anotes.bak Anotes.jou backup, created when you choose BACKUP FILES
Bnotes.jou, etc same as for Anotes.jou, Anotes.bak
Catagoryname.jtx Category saved to disk index file
Categoryname.jtt Category saved to disk data files

Installation:



Quick Instructions for Experienced Users:
1.  For the program to run you must have Vbrun100.dll  and Commdlg.dll  installed in either the

Windows or Windows\System subdirectories.  Vbrun100.dll is available on numerous bulletin boards, if you
are unable to locate, contact the author.  Commdlg.dll is distributed with Windows 3.1

2.  Copy Muscle.vbx and Threed.vbx to either your Windows or Widnows\System directories.
3.  Copy Journal.exe and Journal.hlp to the desired program directory.  I recommend a separate

subdirectory for the program.

Detailed Example Installation
To install the program using the Windows File Manager:

1.  Open two windows in the File Manager (Window-New WIndow).  
2.  Set one window on the subdirectory where where the program files to be installed are located.

This is the subdirectory in which the files are located after you "unziped" them.  This windows will be referred
to as the "SOURCE" window. 

3.  Set the second window on the directory under which you want to create the Journal Program
Directory.  For example, if you want to install Journal in C:\journal subdirectory, then set the window on the
C:\ root directory by clicking on the C:\ at the top of the directory tree.  If you want to install Journal in C:\
Windows\journal  then  click  on  the  C:\windows  subdirectory.   This  windows  will  be  referred  to  as  the
"DESTINATION" windows.

4.  With the focus on the DESTINATION windows, click FILE Menu and select Create Directory....
In the popup dialog box type: JOURNAL.

5.  In the DESTINATION window directory display,  click on the JOURNAL directory window to
switch the DESTINATION window to the JOURNAL directory.

6.  In the SOURCE window, click on JOURNAL.EXE.  While holding down the Ctrl button, click on
JOURNAL.HLP.  Relese the control button.  This should select both files.  Press down the Ctrl button and
"drag" the selected files to the DESTINATION Window.

7.   In  the  DESTINATION windows directory  tree  click  on either  the  Windows directory  or  the
WIndows\System (preferred) directory.  This will change the DESTINATION window directory.

8   In  the  SOURCE  windows,  click  MUSCLE.VBX.   Hold  Down  the  Ctrl  button  and  click
THREED.VBX.  Release Ctrl.  This will select both files.  Hold down the Ctrl button and "Drag" the two files
to the DESTINATION window

9.  Return to the Program Manager.  Select the Group in which you want to install the JOURNAL
program icon.  

10.  Select File Menu.  Under the File Menu, select NEW...
11.  In the New Program Object dialog box, select Program Item(default) and click the OK button.
12.  In the Program Item Properties dialog box, press the TAB key to move the cursor to the

Command Line selection.  Then click the Browse Button.  In the Browse files dialog, move to the JOURNAL
directory and double click on JOURNAL.EXE.  this will return you to the Program Item Properties dialog with
the Journal.EXE program in the Command lline.

13.  Click the mouse in the Working Directory dialog box.  In this box, type the path to the Journal
Directory.  This will establish that directory as the start up directory for JOURNAL.

14.  Click the OK button to complete.

NOTE:   IT  IS  VERY  IMPORTANT  THAT  JOURNAL  STARTS  WITH  THE  STARTUP  DIRECTORY
PROPERLY SET.  IT USES THE STARTUP DIRECTORY TO LOCATE ALL FILES.

Quick Start:
1.  Double click the JOURNAL icon to start the program.  The FIRST TIME you run the program, a

dialog box will popup informing you the initialization file is not found.  that's because you haven't created one
yet.  Click YES to proceed.  (Note:  If you see this dialog box after having run the program once, then most
likely you are not starting the program from the JOURNAL directory.  Check the dialog box for the program
directory in which it is trying to start.)

2.  When the program starts, in addition to the main program screen, you will see a standalone
button labeled DailyClp.  The menu bar caption for this button has the same label.  This button is used to
"Grab" text on the Clipboard and add it as a new topic to Journal.  Whenver text is on the CLipboard which
you would like to save as a topic in Journal, click this button.  The button menu bar caption changes to show
you the size of the text selected from the Clipboard (Journal text is limited to 30K) and a dialog box pops up
for you to type in the topic title.  Type in the title desired and click OK.  This is added to the currently selected
Category in Journal.  This is the easiest way to transfer text information from any windows application to
Journal.   This  works equally well  with  the Journal  program in  an icon.   When Journal  is iconized,  the
currently selected Category is displayed as the caption.  The button remains and can be used as described
above.  The button can be moved by dragging the Menu Caption.



3.  Within the Journal Program, to set up the Categories, click the Topics Menu - Set Categories.
Complete the dialog screen that comes up and select OK.  This will place the Category titles on the button
across the top of the screen as labels, it will also add these captions to both the Switch and Transfer Menus.

4.  To switch categories, click the applicable button or use the Switch Menu and select the category
desired.

5.  To add a new topic, click the New Topic button OR, select Topics Menu - New Topic OR, use
keyboard shortcut Ctrl + N.  To Delete a topic, same choices apply only use Delete Button, Delete Topic and
keyboard shortcut is Ctrl + D.  Ease of both adding new topics and deleting topics is available because
routine housekeeping is as important as keeping new information.

6.  When new topics are added, today's date is automatically appended to the start of the title.  If
this  is  not  desired,  it  can  be turned off  by selecting Topics-Date  Stamp On to  remove the  checkmark
indicating the option is not selected.

7.  To import an ASCII file from disk (capacity limited to 30K), select File-Import.  This brings up a
standard Windows file open dialog box.  Note:  this action makes a copy of the file and adds it to the Journal
database.  To export a file, choose File-Export and type the complete path and filename desired.

8.   Under  the  Topics  menu,  you  can  select   Category Sizes to  determine  the  current  size of
Category files.  The total file size capacity cannot exceed 1Meg.

9.  Most of the rest of the commands are standard Windows commands except for three additional
commands under the separator bar in the Edit Menu.  Strip CrLf will strip CrLfs from the selected text.  You
must select text prior to using this option.  This is very useful when bringing in text, either via File Import or
the Clipboard, which has embedded CrLfs.  Copy All places a copy of the entire topic text on the CLipboard.
This is very useful for copy an entire topic to another application or making a duplicate copy of a topic.  Cut
All-Del Topic copies the entire topic text to the Clipboard AND deletes the topic from the Category.  This is
most useful when you want to combine two topics together.  Select the one you want to delete, then select
Cut All - Del Topic to place the topic text on the Clipboard and to delete the topic.  Then select the topic to
which you want to add the text, place the cursor where you want the text inserted, and choose Edit-Paste.

Detailed Program Instructions
Menu Commands 
All  functions  within  the  program  can  be  executed  from  the  menus.   Note  a  number  of   shortcut
keysSHORTCUTKEYS are available.

Files Menu 

Inport Text 
Select this menu item to inport an ASCII file directly into Journal.  The file is added to the currently selected
category.  The file text is added to the topic and the file name is added as the topic title.  Maximum file size
that can  be inported is 30K.    

Export Text 
Select this menu item to export one of Journal's topics to a file.  When the menu item is selected you are
prompted  for the filename where you want the file save.  The entire path must be specified or the file is
saved in the current  directory.    

Backup Data Files 
This command will make backup copies, in the program directory, of the initialization file (journal.dat) and
each of the data files.  If for any reason one of the files becomes corrupt, the backups may be used.  If any
backup is used then THEY ALL MUST BE USED. To restore, copy each backup to the respective program
file (eg, journal.bak to journal.dat, anote.bak to anote.jou, etc). 
The program is VERY sensitive to the file structures.  These files CANNOT BE EDITED WITH ANOTHER
EDITOR as this would corrupt the files structure.  For further information see the techical information in the
About HelpABOUT section.

Remove Category to File 
This function will remove the selected Category from Journal and save it to disk.  Both the 
index of topic titles and the data are saved.  The titles are saved to file: categoryname.JTX 
and the data to categoryname.JTT.  These files are  located in the Program Directory. 

Add Category from File 
This function will add a category back into Journal that has previously been removed.  
THIS WILL ONLY WORK FOR FILES PREVIOUSLY REMOVED FROM JOURNAL.  The 
data files must be located in the Program Directory.  After selecting this item, a dialog form 



pops up listing the Category files found which can be added back into Journal.  Select the 
category desired by either highliting the item in the Listbox and pressing the OK Button or by 
double-clicking the Category Name in the Listbox. 
The Category button to which you want to bring the Category from disk MUST be an empty 
category. 
An additional use of the Remove Category to File and Add Category from File function is 
that it provides a good way to move selected categories between computers.  For example, 
if you have the program installed both at home and at work; these two functions provide an 
easy way to move categories between the two computers, 

Additionally, if 8 categories is insufficient, additional categories may be created and saved 
to disk until needed. 

Topics Menu 

All commands associated with individual topics are located on this menu selection.  Note the shortcut keys.
Categories can be thouoght of as file drawers, while the topics are individual files within these drawers.  The
topic title is the name of the file and is always displayed in the listbox to the left for selection.  Commands
are  available  to  permit  easy  storage  of  information  and  easy  maintenance.   Tow  of  the  most  used
commands, New Topic and Delete are also available as buttons. 

Set Categories 
This  is  used to  configure  the  Category  buttons andthe  Switch  and Transfer  Menu.   When the  item is
selected, a separate form  opens for entering new titles for any category.  It is inportant to note that changing
a Category Title (and  corresponding button title) does not change any of the topics or topic text associated
with that Category.  Thus you  can change Category Titles any time desired.  

Category Sizes 
This command will pop up a form which will provide the current size of each Category File.  A Category file is
limited to 1 MEG.  This works by measuring the current size of the category file as saved on the disk.  thus
the most accyrate data is obained if the SAVE button is clicked before checking the Category Sizes. 

New topic     Shortcut:  ctrl + N 
This functions exactly the same as the New Topic button.  A title box is opened to type in the title of the topic.
Topic titles  can be up to 45 characters.   The date the topic is created is automatically 9defulat  mode)
appended to the start of the  title.  The topic title is then added is the topic listbox and the cursor is placed in
the text box for entering the  associated text. 

Delete Topic     Shortcut:  ctrl + D 
This item is utilized to remove a topic from Journal.  It functions exactly the  same as the Delete Topic
button.  The  topic title is removed from the listbox, the topic text is deleted, and the remainder of topics
adjusted in position (the  remainder of the topics are rolled up) 

Edit Topic Title 
This is utilized to edit the selected title.  The title is presented in a dialog box.  A new title can be typed or the
existed one edited.  The date is NOT automatically appended.  Note, the entire title text is highlited in the
dialog box presented.  Typing replaces all text.  If you only want to edit the title, then you must press one of
the arrow keys or clilck the mouse within the title to remove the highliting. 

Print topic     Shortcut:  ctrl + P 
Selecting this item prints the current topic.  The topic title is printed as a header. 

Save Topic Data 
This functions the same as the SAVE Button.  All program data is saved. 

Date Stamp On 
If  this  button is  checked,  default  mode,  then today's  date  is  automatically  appended to  topic  titles.   A
checkmark appears in the menu next to this item when it is ON.  To turn off the automatic date stamping,
click the menu item and the checkmark will disappear.  Date stamping will stay off for the remainder of the
session unless turned on.  Whenever the program starts, it starts with date stamping ON. 

Edit Menu 



The Edit Menu provides the normal windows Clipboard editing functions, Cut, Copy, Paste and Delete.  In
addition,  three added functions are provided:  STRIP CrLF strips CrLfs from selected text,  COPY ALL
copies the entire topic text to the Clipboard.  COPY ALL - DEL  TOPIC copies the entire topic text to the
Clipboard AND then deletes the topic. 

Cut 
This cuts the selected text from the topic text and places it on the Clipboard. 

Copy 
This makes a copy of the selected text and places it on the Clipboard. 

Paste 
This inserts the text on the Clipboard into the topic text at the point where the cursor is located. 

Strip CrLf     Shortcut:  ctrl + Z 
Selecting this command will remove  ALL CrLfs from the  selected text.  This is useful when text is brought
into Journal, either via Inport or the Clipboard, which has embedded carriage return-lilne feeds.  Place the
mouse at the start of the text, hold down the left button and drag over the desried text.  After releasing the
mouse button, select this menu item or use the shortcut key, ctrl + Z. 

Copy All 
This will copy the entire text from the topic and place it on the Clipboard.  No change is made to the topic
text.  This  function is most useful to make a copy of the topic text to place into another document or to make
a copy of a topic  and place it in another category. 

Cut All - Del Topic 
This will copy the entire text from the topic and place it on the Clipboard.  After placing it on the Clipboard,
the topic  is deleted.  CAUTION should be exercised, since the topic is deleted, the text should immediately
be pasted in  either another application or another topic.  This function is most useful to combine the text
from two topics together.   Select the topic you want to delete, then select COPY ALL - DEL TOPIC, then
select the topic where you want to  place the text, place the cursor where the text is to be inserted, and
select PASTE to insert the text. 

Switch Menu 
This menu item functions exactly the same as the buttons across the top of the screen, they permit switching
to another Category.  Select the Switch Menu, then click the Category title to which you want to switch. 

Transfer Menu 
This function is used to transfer a topic from one category to another.  To transfer a topic, select the topic
you want  to transfer, then select the transfer menu, then select the category to which you want to transfer
the selected  topic.    The topic  is  then deleted the old  category and transferred to  the newly selected
category.  Within the new category,  the topic is appended to the end of the topic list in that category.  The
title is appended as it was in the old category. 

Exit Menu 
Selecting this item will end the program and save all data files.  Before ending, you are prompted to Make a
Backup of Data Files.  Unless there is some reason to the contrary, this should always be selected.  This
program data file structures are extemely critical to proper performance. 

Help Menu 
Clicking this item will bring up this help menu.  All of the text in this Help file is set for browsing throughout.
This permits reading of the Help much like reading a manual. 

Keyboard Commands 
The most used commands are available as buttons in the upper portion of the program screen.  In addition,
two labels indicate how many topics are contained in the currently selected Category and the size of text in
the currently selected topic.  Maximum number of topics is 200.  Maximum topic text size is 32K. 

Categories 
The eight buttons across the top are used to switch between categories.  The Set Categories selection
under the Topics MenuTOPICS is used to set the individual Category titles.  These titles are displayed as the
button captions, as well as on both the Switch and Transfer menus. 



New Topic 
This button is used to add a new topic to the Journal.  When the button is clicked, a promt appears for the
topic  title.  The title is limited to 45 characters.  The date the topic is created is automatically (default mode)
appended to the beginning  of the topic title. 

Delete Topic 
This button is used to remove a topic from  Journal.  When pressed, the selected topic title is removed from
the llistbox and the  corresponding text deleted.  the remainder of the topics is rolled up to fill in the gap. 

Save Button 
Clicking this button saves all of the program data to disk. 

Shortcut Keys 

ctrl + C     Copy All 
ctrl + D     Delete Topic 
ctrl + N     New Topic 
ctrl + P     Print Topic 
ctrl + S     Save Topic Data 
ctrl + T     Edit Title 
ctrl + X     Cut All-Del Topic 
ctrl + Z     Strip CrLf 

DailyClp Button 
At startup this button is located in the upper right corner of the screen.  Only the actual command button and
the  title bar is displayed.  A single click of the button performs the following: 

-  checks to ensure there is text on the Clipboard 
-  grabs the text from the Clipboard and displays the size in KBytes as the new form title 
-  Opens a dialog box prompting for the new topic title 
-   Pastes the text into the topic 

The topics are added to the currently selected Category in Journal.  The currently selected Category is
Tdisplayed as the title, so even if Journal is in an icon, the text under the icon is the title of the curently
selected  category. 
The button can be move to any location on the screen by placing the mouse in the title bar, holding down
the left mouse button, and dragging to the desired location. 
If the button is accidently clicked and you do not want to paste text, in the dialog box that pops up simply
select the CANCEL button. 
This button is very useful for adding information to the journal from other programs.  Simply place the text
on the Clipboard, click the DAILYCLP button, type in the topic title, and the Clipboard text is added as a new
toppic.  Many programs offer shortcuts for selected all text.  This makes it easy to copy the entire text to the
Clipboard.  For example, in Microsoft Word for Windows, holding down the control button and clicking in the
left  column will select the entire document.  Then pressing the EDIT - Copy menu selection (or the button
on the  toolbar) will copy the entire text to the Clipboard.  With the text on the Clipboard, click the DAILYCLP
button.  The  size of the text is displayed in the title (Journal has a maximum limit of 30K per topic) and a
dialog box pops up for  the topic title.  Individual application documentation should be checked for shortcuts
to copy text to the Clipboard. 

How to .... 

Add new topics
There are three ways to add new topics to a given Category.  If you want to type the information

into the topic, select NEW TOPIC.  Click on the DAILYCLP button to add a new topic and place the text from
the Clipboard into the topic.  When you click this button you will be prompted for the topic Title.  And third,
ASCII files less than 30K can be directly imported using the FILES Menu, Import function.  Selecting this
function opens a standard Windows file open box.  
Add new Categories

Under the Topics Menui, select SET CATEGORIES.  A separate screen comes up in which you can
type the Category name on the button you desire.  If all of the buttons have been used, then you must first
remove one of the categories to disk.  This will free up a button.  On the free button, type up to 8 characters
of text.
Remove a Category but save it to Disk



Click the button of the category you want to remove.  Then under the FILES Menu, Click Remove
Category to File.  This will automatically save the category to disk with the filename equal to the category
name that  was used.   Using this  featture you can actually  have more than 8 categories,  an unlimited
number, but you can only have 8 open at any one time in Journal.  The first category, DailyJou can never be
removed to file.
Add a Category fm Disk

FIrst you must select a category button that is currently empty.  You can not add one category over
the top of another one.  Under the FILES Menu, click ADD CATEGORY fm FILE.  A screen appears listing
the category files currently stored on disk.  Either double click the file name or click once on the file name
and click the OK button.  This will restored the category to Journal.
Add an Electronic Mail Message to Journal

Within the electronic mail program select the message text and copy this text to the Clipboard.
Without closing the electronic mail program, simply click the DAILYCLP button.  This will then prompt for the
title you want for this topic.  The topic is then added to the CURRENTLY SELECTED CATEGORY adding
both the title and the Clipboard text to the topic text.  
About and Technical Info 
Author 
Gordon Smith 
341 RiverBend Road 
Great Falls, VA 22066 
703-759-4415 
CompuServe 72567,3416 
Resources: 
JOURNAL was written using Microsoft Visual Basic (VBRUN100.DLL required), the Microsoft Visual Basic
Professional Toolkit (Threed.vbx required) and MicroHelp Muscle (Muscle.Vbx required).   The Muscle.Vbx
and Threed.vbx runtime libraries distributed  CANNOT be run from within the Visual Basic environment. 

The titles for all topics in all categories, along with the size of the text field with each,  is stored in the file
JOURNAL.DAT.  The text data for the topics is stored in separate files: ANOTE.JOU thru HNOTE.JOU.  The
backups for these files are the same name with the extent .BAK.  When categories are saved to file, the
topic titles and the size of the respective text fields for the category are written to CATEGORYNAME.JTX,
where  CATEGORYNAME  is  the  category  name  assigned  within  Journal.   The  text  data  is  stored  in
CATEGORYNAME.JTT.  These files can be moved, together, from computer to computer but THEY CAN
NOT BE ALTERED BY ANOTHER PROGRAM.

DEFINITION OF SHAREWARE

Shareware distribution gives users a chance to try software before buying it.  If you try a Shareware program
and continue using it, you are expected to register.  Individual programs differ on details -- some request 
registration while others require it, some specify a maximum trial period.  With registration, you get anything 
from the simple right to continue using the software to an updated program with printed manual. 
Copyright laws apply to both Shareware and commercial software, and the copyright holder retains all rights,
with a few specific exceptions as stated below.  Shareware authors are accomplished programmers, just like
commercial authors, and the programs are of comparable quality.  (In both cases, there are good programs 
and bad ones!)  The main difference is in the method of distribution.  The author specifically grants the right 
to copy and distribute the software, either to all and sundry or to a specific group.  For example, some 
authors require written permission before a commercial disk vendor may copy their Shareware.

Shareware is a distribution method, not a type of software.  You should find software that suits your needs 
and pocketbook, whether it's commercial or Shareware.  The Shareware system makes fitting your needs 
easier, because you can try before you buy. And because the overhead is low, prices are low also. 
Shareware has the ultimate money-back guarantee -- if you don't use the product, you don't pay for it. 
DISCLAIMER - AGREEMENT

Users of JOURNAL must accept this disclaimer of warranty: "JOURNAL is supplied as is.  The author 
disclaims all warranties, expressed or implied, including, without limitation, the warranties of merchantability 
and of fitness for any purpose. The author assumes no liability for damages, direct or conse- quential, which 
may result from the use of JOURNAL." 
JOURNAL is a "shareware program" and is provided at no charge to the user for evaluation.  Feel free to 
share it with your friends, but please do not give it away altered or as part of another system.  The essence 
of "user-supported" software is to provide personal computer users with quality software without high prices, 
and yet to provide incentive for programmers to continue to develop new products.  If you find this program 



useful and find that you are using JOURNAL and continue to use JOURNAL after a reasonable trial period, 
you must make a registration payment of $25.00 to Gordon Smith.  The $25.00 registration fee will license 
one copy for use on any one computer at any one time.  You must treat this software just like a book.  An 
example is that this software may be used by any number of people and may be freely moved from one 
computer location to another, so long as there is no possibility of it being used at one location while it's being
used at another. Just as a book cannot be read by two different persons at the same time. 
Commercial users of JOURNAL must register and pay for their copies of JOURNAL within 30 days of first 
use or their license is withdrawn. .

Anyone distributing JOURNAL for any kind of remuneration must first contact Gordon Smith at the address 
below for authorization. This authorization will be automatically granted to distributors recognized by the 
ASP as adhering to its guidelines for shareware distributors, and such distributors may begin offering 
JOURNAL immediately (However Gordon Smith must still be advised so that the distributor can be kept up-
to-date with the latest version of JOURNAL.). 

You are encouraged to pass a copy of JOURNAL along to your friends for evaluation.  Please encourage
them to register their copy if they find that they can use it. 

Although the author is not yet a member of ASP, Journal is a Shareware program conforming to standards 
as established by the Association of Shareware Professionals (ASP) located at 325  118th Ave.  S.E., Suite 
200, Belleview, WA 98005.  The author will provide the following support:

-  Telephone support to registered users
-  Support via mail, all letters sent will be answered
-  Electronic mail support via Compuserve (Acct 72567,3416)  (preferred method)
-  This is a fully functioning product with no crippling
-  There are no undocumented features
-  The program has been throughly tested.

Although this  program is produced by a non-member of the Association of Shareware
Professionals (ASP), the ASP standards and principals are fully supported and the author will comply with all
ASP standards and practices.  ASP wants to make sure that the shareware  principle works for you. If you 
are unable to resolve a  shareware-related problem with an ASP member by contacting the member
directly, ASP may be able to help. The ASP Ombudsman can help you  resolve a dispute or problem with an 
ASP member, but does not provide  technical support for members' products.  Please write to the ASP
Ombudsman at 545 Grover Road, Muskegon, MI 49442 or send a CompuServe  message via CompuServe 
Mail to ASP Ombudsman 70007,3536.


